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Introduction to Overlay Maker®

Macintosh Tutorial

About Overlay Maker
Overlay Maker is a simple, easy-to-use drawing program that allows you to create your own custom
overlays for IntelliKeysâ. It comes with the IntelliTools Picture Library of over 300 graphic images. You
can also add pictures from your favorite clip art source or use digitized photos. Keyguards are also
available from IntelliTools to help prevent unintentional keystrokes.

With Overlay Maker, you can design overlays to enhance cognitive and physical access to the computer for
people with disabilities. Beginning readers and writers can benefit by using simple overlays designed with
keys that combine pictures and text. For people with physical limitations, the keys can be sized to suit their
needs. The background and text color can be chosen to accommodate visual and processing difficulties.
Overlays can be printed out and laminated. The possibilities for creating custom overlays are endless.

About this Tutorial
Using this tutorial you will learn how to create custom overlays by drawing keys on the computer screen,
adding text labels, and changing the size, shape and color of keys. You will also learn how to add special
commands to take advantage of the unique read and delete features of IntelliTalkâ. Finally, you will send
your finished custom overlay to IntelliKeys and use it with IntelliTalk.

Overlay Maker is available for Macintosh and Windows computers.  Listed below are the materials needed
to do this tutorial.

Materials Needed
TUTORIAL
Introduction to Overlay Maker Tutorial

PRINTED OVERLAYS FOR EACH COMPUTER
6 Key Overlay,* [Optional:  Circle Time–Weather, Spelling List, Big as a Bear]

SOFTWARE
Overlay Maker, IntelliTalk, I Can WriteÔ Strategy Series Files,* I Can Write Slideshow*

HARDWARE
IntelliKeys and cable, two switches

*Items with an (*) can be found on the web/tutorial CD-ROM available free from IntelliTools

IntelliTalk Travel Overlay
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Introduction to Overlay Maker®

Macintosh Tutorial

1. Get Ready to Make Your Overlay
• Open Overlay Maker®.

• Make sure you have a new, blank overlay on your screen.

• Go under File to Save. Select Save and name the overlay Travel Overlay. Notice you are
saving your overlay in Standard Format. For this tutorial we will save the overlay on the Desktop.
While you are working on your overlay, save your work every 10 minutes!

2. Create Six Keys

• Select the Key Tool : 

• Click and drag diagonally to create a key
roughly the size of the key on the right (6 x 9).

• Go to the Edit menu and select Copy.

• Use Paste in the Edit menu 5 times to make a
total of 6 keys.

• Arrange the keys to look like the overlay
below.

3. Add Text Labels

• Click to select the Text Tool: 

• Click inside each key and type text: I saw,
I rode, etc.
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4. Change the Shape and Color of the Keys
• Now you will change the shape of the read and

delete keys.

• Select the Pointer Tool .  
Click once on the read key.

• Hold down the Shapes Palette Tool 
and select the circle.

• Hold down the Key Fill Palette Tool  and
select a color for the key.

• Now change the color and shape of the  delete
key.

5. Add Pictures to the Keys
• Select Picture Library from the Edit menu.

• There are 3 ways to explore the Picture Library
of over 300 pictures: 1) by category, 2) by
typing in the first letter of the name of the
picture you want, and 3) by using the scroll
bar.

• Select the 'train' picture and click on Copy.

• Click once on the key that says the train.

• From the Edit menu, choose Paste.

• Add a picture to the bus key.

6. Add Background Color
• Hold down the Background Palette Tool

and choose a color for the background screen.



Intro to Overlay Maker Mac Tutorial IntelliTools, Inc., 1720 Corporate Circle, Petaluma, CA  94954-692 4    Materials may be freely reproduced
Rev. 12/8/98 Phone: 800-899-6687, Fax 707-773-2001, Email: info@intellitools.com Page 4 of 7

7. Add Content to the Language Keys
• Click on the key labeled I saw. Select

Edit Content from the Keys menu or
double-click on the key. Click on Show
Special.

• Type I saw into the Key Content box. Make
sure you leave a space after each word.

• Click on Other from the menu to bring up the
Special Characters menu. Select Non-
Repeating  and click on Add Special. Select
OK.

• Non-Repeating  will prevent the key from
repeating over and over if held down too long
by the student.

• Repeat the above three steps to add content to
the I rode key.

• Double Click on the key labeled the train to
edit the content. Type the train. Be sure to
add a period and two returns  to the key. The
return  is found in the Keyboard Keys
menu. Add Non-Repeating  from the menu
Other. The returns  are used to separate the
sentences for a beginning reader.

Note:  Pressing return on the computer
keyboard will NOT add return to the key
content.  The procedure for adding returns to
the key content is:  Go to the Special Keys
menu.  Select Return, and click on Add
Special.  (You will need to do this twice to
add two returns).

• Edit the content for the bus key with the
appropriate text, a period and two returns. Add
Non-Repeating  from the menu Other.

FYI
Another Way—"Same as Text Label"

• When you create a key and type text on the
key, the key content automatically defaults to
Same as Text Label.

• To take advantage of Same as Text
Label, make sure that what you have typed
on the key is exactly what you want the
computer to receive.

• You can add special characters such as
Space  and Non-Repeating. Simply place
your cursor after Same as Text Label  and
then add special characters as you did above.
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8. Create the Read and Delete Action Keys
• Click on the read key. Select Edit Content

from the Keys menu or double-click on the
key.

• Add Command ra as the content of the read
key. Press the Command [1] key and the
letter r at the same time. Then, type the letter a.
Don't add any spaces or capitalization. (See
picture). Add Non-Repeating.

• In the same manner, select the delete key and
add Command dw Command dw Non-
Repeating. Note: Command dw is repeated
because on this overlay students type two
words at a time. The delete key works with
IntelliTalk® which allows students to delete two
words at a time.

9. Setting the Key Content for Switches
IntelliKeys® has two switch ports. You can set the switch content from the Overlay menu. Both switch and
IntelliKeys users can work together on the same activity.

• Select the Overlay menu on the Menu Bar.

• Select Switch 1.
 
 
• Type I went to Travel Town. Be sure to

add a period and two returns  (use the
keyboard keys to add the 2 returns.
Make sure your key content looks like
the diagram to the right)  to the key content
for the switch. Add Non-Repeating. Click on
OK.

 

• Select the Overlay menu on the Menu Bar.

• Select Switch 2.

• Let’s make this switch cause the document to be
read aloud. Add Command ra as the content.
Add Non-Repeating. Click on OK.

10. Save and Send the Overlay
• Save your file.

• From the File menu, select Send Overlay [1 D]. This sends the overlay to IntelliKeys®.
You do not have to quit Overlay Maker.  You can leave Overlay Maker open in case you need
to edit your work.



Intro to Overlay Maker Mac Tutorial     IntelliTools, Inc., 1720 Corporate Circle, Petaluma, CA  94954-6924          Materials may be freely reproduced
Rev. 12/8/98 Phone: 800-899-6687, Fax 707-773-2001, Email: info@intellitools.com Page 6 of 7

11. Test the Overlay and Switches
• Open the word processor IntelliTalk. Set IntelliTalk to Speak Words and Speak

Sentences.

• Slide the printed overlay onto IntelliKeys.

• Press keys on the overlay and hear the words spoken by IntelliTalk. Try the switches.

• Below is a copy of the Travel Overlay. Double-click on any key to view its contents.

12. Saving Your Overlay as Content-Only
Here's a strategy to quickly send an overlay to the IntelliKeys: save it as a Content-0nly overlay. Simply
double-click on the Content-Only overlay and the overlay is automatically sent to IntelliKeys.

• Throughout this tutorial, you have been saving
your overlays in Standard Format. Now
you'll save it as a Content-Only overlay.

• Choose Save As from the File menu. Next to
the word Format, click and hold to pull down
the Standard menu to select Content-Only.

• Once you save an overlay as Content-Only,
you can not reopen it and change the content.
For this reason, it is important to save your
Content-Only overlay with a name different
from your original.

• One way to do this is to type .omc at the end of
your file's original name. This stands for
overlay maker content. For example, if your
original is named 6 Key Overlay, change the
name to 6 Key Overlay.omc.

• Save the overlay on the Desktop for this tutorial.
Notice how the appearance of the icon has
changed. A Content-Only icon has an arrow.
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13. Use Your Content-Only Overlay
• Quit Overlay Maker®.

• Send the overlay by double-clicking on the
Content-Only icon. Notice how the overlay is
sent to IntelliKeys® without opening Overlay
Maker.

• Use your overlay with IntelliTalk®.

• You can store this Content-Only overlay on
your Desktop or in the Apple Menu. (Hint: Go
to the System Folder and find the Apple Menu
Items folder. Place the Content-Only overlay
in the Apple Menu Items folder.)

14. Design and Create Your Own Overlay

Put what you've learned about making overlays into practice.

• Now you will design and create your own 6 key
overlay that will be used with IntelliTalk®. A
preprinted overlay with 6 blank keys has been
provided.

• Decide what kind of overlay to make. If you are
working as a team, you will make one overlay
per team.

• Follow the steps outlined in the Travel
Overlay. If no printer is available, use your
artistic talents to draw on the squares. Save your
work.

• Send the overlay to IntelliKeys® and use it with
IntelliTalk.



    

Appendix
A. Overlay Maker® Feature Highlight Sheet

B. Workshop Outline for the Trainer
Suggestions for incorporating the Overlay Maker tutorial in a workshop format

C. I Can WriteTM Strategy Series
Suggestions for using Overlay Maker and IntelliTalk to develop basic reading and
writing skills

D. Overlay Maker Activity Overlays
A brief description of the overlay activities that come with the Overlay Maker
program

Five-Pac and Multi-User Pricing Available
Call 800-899-6687 for information



Introduction to Overlay Maker®

Feature Highlights

Overlay Maker is a simple, easy to use drawing program that allows you to
create your own custom overlays for the IntelliKeys® keyboard.

Steps to Creating an Overlay

• Plan purpose and appearance
• Add keys to the overlay
• Add text and picture labels to keys
• Adjust the appearance of the overlay
• Edit the key content
• Save, print, send and test overlay

Four different selection tools

• Pointer Tool
• Key Tool
• Line Tool
• Text Tool

Four ways to modify an overlay key

• Change the shape
• Alter the thickness of the border
• Change the color of the border
• Change the color of the inside of the

key.

Four ways to modify the text

• Color
• Size
• Font
• Style

Four categories under the Key
Content’s Show Special Menu

• Keyboard Keys

• Mouse Actions

• Other (Non-Repeating, Levels, etc.)
• Setup characters (set Response Rate,

etc.)

Four ways to save an overlay

• Save as Standard overlay file: 

• Save as a Content-Only Overlay: 

• Save as a PICT: 

• Save as a Template: 

 Five ways to send an overlay

• Send from Overlay Maker Application
• Send from Overlay Sender Application
• Drop overlay icon onto Overlay Sender

icon
• Attach to application with ClickIt!™
• Double click on Content-Only overlay

Additional ways to customize overlay

• Change the background color of overlay
• Assign keyboard actions or text to

switches
• Group overlays for easy access

Importing Graphics

• 300 pictures in the Overlay Maker Picture
Library  can be imported either in color
or  black/white

• Pictures can also be imported or exported
from other applications through the
Clipboard

Printing Overlays

§ 8 1/2 x 14 legal size paper landscape mode

§ 8 1/2 x 11 paper landscape mode (you will
have to glue 2 pieces together)

Five-Pac and Multi-User Pricing available.
Call 800-899-6687 for information.



Introduction to Overlay Maker®

Workshop Outline for the Trainer
Estimated time:  2 hours

If you are using this tutorial as part of a workshop on Overlay Maker, this section will help you prepare
the materials and equipment you will need as well as provide you with a suggested workshop outline to
follow.  Please feel free to duplicate the Overlay Maker tutorial and any of the files referred to in the
tutorial, for distribution at your trainings.

MATERIALS NEEDED

• Print one set of overlays for each computer prior to the workshop. Include the Spelling List, Circle
Time—Weather, Big as a Bear, and I Can Write 7 Letters as well as the Travel Overlay. (Instructions
for making the Travel Overlay are part of the Overlay Maker tutorial. Other files can be found on the
web/tutorial CD-ROM available free from IntelliTools).

• Each participant should bring two blank, formatted disks for copying IntelliTools Training Materials
files as well as any activities made during the workshop.

OVERLAY MAKERâ WORKSHOP OUTLINE

Introduction to Overlay Maker . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5 minutes

Overview of Program
• Show menus, tool bar, and palettes to demonstrate how it’s similar to a standard drawing program.

• Explain what the grid lines are (24 x 24 matrix for a total of 576 cells).

Try Samples (send from Overlay Maker using IntelliTalk®) . . . . . . . . . . . . . . . . . . 20 minutes
• Hold up and discuss overlays:  Big as a Bear, Spelling List, Circle Time–Weather

For each sample:
• OPEN the overlay.

• SEND the overlay to IntelliKeys®.

• PLACE the printed overlay onto IntelliKeys. Pretend they printed it out.

• USE the overlay with IntelliTalk®.

Overlay Sender . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5 minutes
• Try sending overlays with Overlay Sender by both double-clicking on Overlay Sender and dragging

overlays onto its icon.

• Make an alias of Overlay Sender and put on the desktop.

Introduction to Overlay Maker Tutorial . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40 minutes

(Follow printed tutorial)

Be sure to explain special key contents on the overlay such as two returns for separating sentences to help
beginning readers, and two deletes (useful because each text key inputs two words at a time).



Create 6-choice communication board/dialog (optional) . . . . . . . . . . . . . . . . . . . . . . 30 minutes

• This is the final and most open-ended exercise. If you have a printer available for each computer team,
you can make this even more open-ended. The idea is that you are providing a “blank” printout (six
blank keys). Each computer team decides what kind of overlay to make, calling upon their experiences
with overlays over the course of the workshop. Each team makes an overlay, either printing it out on a
printer or drawing in the blank squares of the 6 Key Overlay. They send the overlay to IntelliKeys and
use it with IntelliTalk. Participants circulate around the room trying out the various creations.

I Can Write™ Files* . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15 minutes

• Show the I Can Write PowerPoint slideshow

• Show the 4 “Kittens” sample overlays from the folder.

• Show participants where to locate the I Can Write Series Files in Training Materials folder.

• Open the I Can Write™ 7 Letters. temp file. Use the word “kittens.” Save overlay and use IntelliTalk®.

*Files are on the web/tutorial CD-ROM available free from IntelliTools.

Discuss the value of content-only overlays . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5 minutes

• Easy to access.

• Can be placed under Apple Menu.

• Demonstrate the overlay with the Snap-In™ Keyguard.



I Can WriteTM Strategy Series
Fostering Writing with Overlay

Maker and IntelliTalk

I Can Write™ gives teachers a step-by-step method for teaching beginning writing skills using
IntelliKeys®, IntelliTalk®  and Overlay Maker®. This method consists of two approaches, writing letter by
letter and word by word. Students learn to find specific letters on the keyboard, to read and type basic
words made with these letters, and then to write simple stories using the same words.
A set of ready-to-use overlays takes teachers through this process. The set of customizable overlay
template files accompanying this tutorial allows teachers to add their own letters, words and sentences.
Teachers can print one copy of each of the blank templates on legal size paper and then Xerox them and
use them as black line masters. Rather than take the time to print a new overlay for each new letter or
word, teachers can write on the Xeroxed copy and use the overlay right away!

Steps to Using I Can Write Templates:

• Choose the file with the number of targeted letters or words you need.
• Type the targeted letters or words.
• Save the overlay.
• Write the words on the Xeroxed blank overlay or print the overlay.
• Send the overlay to IntelliKeys keyboard.
• Open a new IntelliTalk file. Set the Speech menu to Speak letters, Speak Words and Speak

Sentences (you may choose to turn off letter by letter when using the I Can Write Word by
Word templates).

• Place the overlay on IntelliKeys and use with IntelliTalk™.
• Students can hear all their work read back by pressing a switch connected to IntelliKeys.

Files Included with this Tutorial:

I Can Write Letter by Letter Folder

• 8—I Can Write Letter templates—designed for targeted words with two to nine letters
• 1—I Can Write Blank Keybrd.temp—designed for just the targeted letters
• 1—I Can Write Full Alphabet.temp—complete with lowercase letters
• 1—IntelliTalk Alphabet.temp—complete with lowercase letters, vowel cueing, special read keys

that take advantage of the read word and sentences feature of IntelliTalk and punctuation, keys.

I Can Write Word by Word Folder

• I Can Write Word by Word 1.temp—designed to accommodate a beginning language pattern
of noun/verb/adjective. For example: The kittens are soft.

• I Can Write Word by Word 2.temp—designed to create more complex sentences, form plural
words by adding an ‘s’, and use conjunctions. For example: The dogs are large and brown.

• I Can Write Word by Word 3.temp—designed  for additional language options.



I Can Write Samples Folder - sample ideas for teachers

• I Can Write 7 Letters Kittens overlay  - a sample file using the word kittens.
• I Can Write Kittens Keyboard overlay - a sample file using the letters in kittens with words in

the My Words box to help students learn how letters can be used to form new words.
• I Can Write Word 1 Kittens overlay - a sample file showing how several simple sentences can

be formed to help foster language development.
• I Can Write Word 2 Kittens overlay -  a sample file using more complex language possibilities.

I Can Write Kittens Sample Files

I Can Write 7 Letters Kittens Overlay

Skills

• Tracking left to right
• Letter and word recognition
• Building w ords from a set of letters
• Building simple sentences
• Building complex sentences
• Singular and p lural
•  Mastering the keyboard

Letters of a favorite word are placed within the
spaces of a blank letter template. This helps the
student sequence letters from left to right and to
write the word successfully.

I Can Write Kittens Keyboard Overlay

Next the letters of the word are placed within a blank
alphabet layout. The student learns to use the letters
in creating other words.

Here is a sample list of some of the words generated
using only the letters in the word 'kittens'.



I Can Write Strategies Series

I Can Write Full Alphabet Overlay IntelliTalk Alphabet Overlay

Students can progress to a full alphabet overlay. The
vowel letters are color cued to help students with
spelling.

This overlay takes advantage of the special read
features of IntelliTalk®. Students can easily read a
word, read a sentence or read all of their work.

I Can Write Word 1 Kittens Overlay I Can Write Word 2 Kittens Overlay

Students can press the keys to write word by word.
They can write sentences such as "The kittens are
purring."

This more advanced overlay uses the singular and
plural form of the verb as well as connecting words
like "and" and "not".



Overlay Makerâ Activity Overlays

The overlays found in the Activity Overlays Folder in Overlay Maker® provide access, auditory feedback and ideas for
modification to the curriculum. The overlays are included with Overlay Maker to be printed in black and white or in color.

The overlays can be used right away or customized for individual needs.

Today 
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sun rain

snow wind
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ice 
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hot dog

car

bird
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Return

clock

apple

ba
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airp ane

Circle Time - Weather
This is a primary way to report the weather.

Matching Game
Allows the student to practice independently matching

pictures and words. Easily customized for any level.
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Delete

Readz
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Calendar
Practice the calendar with the date, month, and year.

Spelling List IT 1.1
The word flashes, speaks and disappears ready for  letter

input using IntelliTalk. Easy to modify for weekly words.

scary

fast

as

a goose

Print

a hare

quiet slow

an ox

a rat

a beara dogcuddly stub-
born a frog

a moose

a cat

furry

big small

a fox

hungry

heavy ight bo d
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stinky mi d thirsty

loud

eager

shy

.,Read
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coarse smooth

hamburger pizza burrito

mi k soda pop juice

app e banana grapes

print

read
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I want

That’s 
all

cookies browniesice cream

Lunch Choices
It is a communication board and a way to plan the daily

menu. Personalize for individual diets.

Big As A Bear
Reading the book Quick as a Cricket by Audrey Wood

sparks this language activity extension.
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Pendulum  Experiment

We changed We learned that 

the weight.

the angle. 

the length. 
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he same number 
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Print Save
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Survey of Classroom
Sampler to show how data can be collected and printed. This

activity can be a starting point for a variety of math
activities.

Pendulum Report
This sample of a science activity allows every student  to
participate in the activity and record responses accurately.
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Delete
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dough though through

fro throw coin

toe two scowl

potato thought snow

oatmeal rodeo code

coincidence growl goat

Long O Sounds
Press Here

to Start

Delete

Print

Save

Repeat

Long O Sounds
How can the student identify the sounds if they are unsure of

the pronunciation? This overlay with IntelliTalk fosters
success.

Multiplication Tables
IntelliTalk will not correct the answers but will help with

auditory feedback during practice! Easy to modify.
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Hiking
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Booties
S-M-L
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Insoles

Feet
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Go  To 
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Go  To 
 Hiking Rental

Press To Start
Foot Wear

Tevas

Shift w x y z Shift
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i j k l m n o p
a b c d e f g h

Return
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Lock
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'. ! ?
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Foot Wear Sales
IntelliKeys joins the work force as sampled with this
overlay. This is the overlay attached to the inventory
database at the shoe store.

Teacher Modification of Basic Overlay
This is a sample of how a teacher modified the Basic
Overlay found in the Standard Overlays Folder. The letters
have been presented as lower case and  cueing of the vowels
assists spelling.


